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INTRODUÇÃO 

 

Genexus é uma suíte de desenvolvimento de código de baixo nível que permite a rápida geração de 

aplicativos de software em várias linguagens e plataformas. Genexus oferece várias vantagens: é fácil de 

aprender, altamente produtivo, multiplataforma e à prova de futuro, protegendo assim seus ativos 

digitais e simplificando a adoção de novas tecnologias. 

Por exemplo, Genexus gera aplicativos para Web e/ou para dispositivos móveis (de um relógio de pulso, 

um telefone celular, um tablet ou uma TV), para a plataforma de destino selecionada pelo desenvolvedor 

(uma determinada linguagem, banco de dados, ambiente, plataforma, com Web design responsivo, etc.). 

Este documento é um guia para iniciantes desenvolverem aplicativos com Genexus. 

COMEÇAR A UTILIZAR GENEXUS 

 

Ao abrir Genexus, você verá uma interface semelhante ao seguinte, conhecido como IDE (Integrated 

Development Environment). Essa interface é fácil de usar e pode ser parametrizada por cada 

desenvolvedor. 

 

É composto de diferentes janelas: 

1. Janela principal (Página de início): mostra dinamicamente informações técnicas sobre a ferramenta e 

a Comunidade GeneXus (notícias e soluções publicadas por outros desenvolvedores). Ele também exibe 

projetos abertos recentemente e oferece a capacidade de criar um novo projeto. 

2. KB Explorer: mostra objetos e configurações do projeto aberto atualmente. 

3. Barra de ferramentas: mostra uma interface fácil de usar para as funções mais utilizadas em GeneXus. 



 

 

                                                                   

www.genexus.com      |       4 

4. Janela de propriedades: exibe as propriedades associadas ao contexto em que o desenvolvedor está 

posicionado (como um objeto selecionado, atributo, variável, controle, etc.). 

5. Saída: mostra a saída das ações realizadas. 

 

CRIAÇÃO DE UMA NOVA APLICAÇÃO COM GENEXUS 

 

Para começar a desenvolver uma nova aplicação com GeneXus, você deve criar uma nova Base de 

Conhecimento (uma Base de Conhecimento é um projeto GeneXus). 

 

Selecionar File > New > Knowledge Base na barra de ferramentas mostrará a seguinte caixa de diálogo: 

 

A aplicação que será definida ao longo deste documento é uma aplicação real, mas simplificada para 

uma farmácia. Portanto, faz sentido que a Base de Conhecimento seja chamada de "Farmácia" (ou 

"Farmácia" ou "Sistema de Farmácia", entre outras opções). Em seguida, você deve inserir o caminho no 

qual deseja criar essa Base de Conhecimento. 

 

O próximo passo consiste em selecionar se deseja que os programas de prototipagem gerados por 

GeneXus permaneçam em sua máquina local ou na Nuvem GeneXus. Selecione “GeneXus Prototyping 

Cloud” na caixa de combinação Prototyping Target. 
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O combo User Interface Language permite selecionar o idioma no qual você quer que GeneXus gere os 

títulos dos botões criados automaticamente, etiquetas, mensagens para usuários, etc. O idioma padrão é 

o inglês. 

 

Na caixa Back end você deve indicar: 

● Uma das linguagens de programação disponíveis no combo chamado Prototyping 

Environment. GeneXus usará a linguagem que você seleciona para gerar os programas 

aplicativos de back end, assim como os programas necessários para criar e manter o 

banco de dados. Por padrão, o idioma selecionado é .NET. Deixe assim. 

● O DBMS no qual o banco de dados será criado, acessado e mantido. O combo Data 

Source oferece o SQL Server por padrão. Deixe assim. Mais tarde, os detalhes do banco 

de dados precisarão ser inseridos. 

 

A caixa Front end permite indicar as linguagens de programação desejadas para que GeneXus gere o 

front end das aplicações. Por padrão, o idioma selecionado para gerar o front-end dos aplicativos da Web 

é .NET. Outros também podem ser selecionados para gerar aplicativos Web e/ou Mobile. Nesse caso, ele 

usa .NET. 

 

Ao pressionar o botão Criar, GeneXus inicia o processo de criação da Base de Conhecimento. 
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DEFINIÇÃO DOS PRIMEIROS OBJETOS 

 

Depois de criar uma nova Base de Conhecimento, você precisará descrever as visualizações dos usuários. 

Para isso, você precisa identificar os objetos da realidade (recomenda-se prestar atenção aos 

substantivos que os usuários mencionam em suas descrições, como: produtos, faturas, clientes, etc.) e 

começar a defini-los usando objetos GeneXus. 

 

Os desenvolvedores GeneXus não trabalham em tarefas de baixo nível, como definir tabelas, normalizar, 

desenhar programas, programar, etc. Em vez disso, seu trabalho é uma atividade de alto nível que 

envolve descrever a realidade dos usuários. Depois disso, GeneXus analisa os objetos definidos e passa a 

desenhar o banco de dados e os programas aplicativos para a plataforma selecionada de forma 

totalmente automática. 

 

Suponha que a farmácia que solicita o aplicativo queira registrar os Produtos que tem à venda. 

 

Para descrever cada objeto identificado da realidade, deve-se criar um objeto GeneXus do tipo Transação 

(não está relacionado ao conceito que se refere a transações de banco de dados). Para fazer isso, crie um 

objeto Transação que descreva os Produtos. 

 

Selecione File > New > Object na barra de ferramentas. Será exibida a seguinte caixa de diálogo, 

permitindo que você selecione o tipo de objeto que deseja criar (neste caso: Transação) e insira um 

nome para ele (neste caso: Produto). 

 

 
  



 

 

                                                                   

www.genexus.com      |       7 

Ao clicar no botão Criar é criada a Transação do Produto e a mantenha aberta para começar a definir sua 

estrutura: 

 

Cada Transação possui algumas seções que serão explicadas gradualmente. Especificamente, a estrutura 

(Structure) de uma Transação permite definir os atributos ou campos que descrevem um objeto da 

realidade. 

Suponha que a farmácia lhe dissesse que para cada produto você precisa registrar seu código, nome, 

preço de venda, estoque e tipo (medicamento, cosmético, etc.). Portanto, esses dados que devem ser 

registrados para cada produto coincidem com os atributos que você deve criar para esta Transação. 

Observe na imagem acima, que a primeira linha na estrutura Transaction está automaticamente pronta 

para você definir o primeiro atributo. Além disso, observe que um ícone com a imagem de uma chave 

está associado a essa linha. Isso porque em cada Transação, um atributo, ou conjunto de atributos, deve 

ser configurado com a função de um identificador único ou chave primária. 

 

O conceito de identificador único ou chave primária visa identificar de forma única cada produto (ou 

qualquer objeto na realidade). Em outras palavras, os usuários finais do aplicativo não poderão inserir 

dois produtos com o mesmo valor de identificador. Claramente, o atributo de chave primária da 

Transação do Produto é o código do produto. Veja como defini-lo. 

 

Se você pressionar a tecla ponto no teclado, GeneXus mostrará automaticamente o nome da transação 

como prefixo no nome do atributo: 
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Resta apenas escrever Code após o prefixo do Produto: 

 

Em seguida, pressionando a tecla Tab, você pode escolher o tipo de dados a serem armazenados para 

este atributo. O tipo de dados padrão é: numérico de 4 dígitos sem decimais. No entanto, a farmácia 

solicitou que o código do produto tenha sempre um valor numérico de até 10 dígitos, portanto, você 

deve alterar seu comprimento para 10: 

 

 
 

Pressionar Enter abre uma nova linha onde você pode começar a definir o segundo atributo. Novamente, 

você deve pressionar a tecla ponto final no teclado e preencher o nome do atributo com Name, ou seja, 

ProductName (do tipo Character e comprimento 50): 

 

 
 

 

Agora você deve adicionar o atributo ProductPrice (do tipo Numérico, com 9 dígitos e 2 casas decimais): 
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Como você provavelmente precisará criar mais atributos para definir preços ou quantidades (ou seja, 

quando a farmácia comprar ou vender produtos), pode ser uma boa ideia criar um tipo de definição 

genérica para todos os preços. Para isso, na coluna Tipo, basta escrever: “Price =”, antes do tipo 

selecionado: 

 

Em seguida, pressione Enter e você verá que o atributo ProductPrice terá sido definido para digitar Price: 

 

A definição de Price com tipo numérico (9 dígitos com 2 casas decimais) é chamada de Domínio. 

 

Os domínios permitem definições genéricas. Um dos benefícios dos domínios é que, se posteriormente 

você precisar que os preços sejam numéricos de tamanho diferente, basta alterar a definição do 

domínio para atualizar todos os atributos com base nesse domínio em uma etapa só. 
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Para ver os domínios criados na Base de Conhecimento, selecione View > Domains na Barra de 

Ferramentas: 

 

Como você pode ver na imagem, GeneXus cria alguns domínios automaticamente. Ao clicar em um 

determinado domínio, a janela de propriedades é atualizada mostrando as propriedades do domínio 

selecionado. Observe que, além de definir o tipo de dados para um domínio, você também pode definir 

outras propriedades interessantes. 

 

A janela Propriedades será atualizada cada vez que você selecionar outro atributo, domínio, objeto, etc., 

com as propriedades correspondentes disponíveis para configuração em cada caso. Se não estiver visível, 

você pode pressionar F4 para abri-lo. 

 

Retorne à Transação do Product, onde o próximo atributo que você deve definir é ProductStock do tipo 

numérico e comprimento 4: 
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Agora é necessário registrar o tipo de produto. Você pode criar um atributo chamado ProductType como 

Character(50)... 

 

Mas e se os usuários quiserem inserir dois produtos do mesmo tipo? Eles teriam que digitar o mesmo 

nome de tipo duas vezes, tomando cuidado para escrevê-lo exatamente da mesma forma! Mais tarde, 

eles podem precisar pesquisar todos os produtos de um determinado tipo e, para obtê-los, o tipo deve 

ter sido escrito exatamente da mesma forma. 
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Parece mais razoável inserir o tipo apenas uma vez, em um local, e a partir daí, para cada produto, 

atribuir o tipo de produto correspondente. Portanto, devemos remover o atributo ProductType da 

estrutura e salvar a Transação do Produto conforme mostrado: 

 

 

Para cada Transação, GeneXus desenha automaticamente uma interface Web (Web Layout) baseada na 

estrutura (Structure) definida. Essa interface da web permitirá que os usuários do aplicativo adicionem, 

atualizem e removam produtos em tempo de execução: 
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Agora prossiga para criar outra Transação para registrar os tipos de produto, para então atribuir um tipo 

de produto a cada um dos produtos. Para isso, selecione File > New > Object novamente e complete o 

seguinte: 

 

 

Para cada tipo de produto você tem que registrar seu código e nome do tipo de produto, então você deve 

criar os dois atributos mostrados: 
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Lembre-se da recomendação de pressionar a tecla ponto do teclado ao definir os atributos, para que 

GeneXus escreva automaticamente o nome da transação como prefixo, bastando apenas 

completar o final dos nomes dos atributos. 

 

Nomear atributos com o nome da transação como prefixo não apenas facilita e agiliza a definição de 

atributos. Também é uma convenção da comunidade GeneXus para facilitar a compreensão ao ler 

um nome de atributo onde quer que esteja, para saber qual objeto está descrevendo. 

 

 

Observe as propriedades do atributo ProductTypeCode: 

 

Observe a propriedade Autonumber. Está configurada como Falso por padrão. Ao alterá-lo para True, 

todos os novos tipos de produtos inseridos pelo usuário final serão numerados automaticamente de 

forma consecutiva. Portanto, ele define a propriedade Autonumber como True para esse atributo 

identificador e salva a Transação ProductType. 
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Conforme explicado acima, cada Transação possui uma interface Web (Web Layout) desenhada 

automaticamente por GeneXus de acordo com sua estrutura. A imagem a seguir mostra a interface da 

Web ProductType: 

 

Agora, atribua um tipo de produto a cada produto. Para isso, volte para a Transação do Produto, adicione 

uma nova linha em sua estrutura e escreva a letra “P”. Você verá a lista de atributos existentes na Base de 

Conhecimento que começam com essa letra: 

 

 
 

Selecione ProductTypeCode e você verá a definição completa do atributo. 
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Nesta Transação você também deve incluir o atributo ProductTypeName, pois quando os usuários 

executarem esta Transação e selecionarem um código de tipo de produto, eles desejarão ver o nome 

correspondente do tipo de produto. 

 

Concentre-se nesses dois atributos, que estão incluídos em mais de uma Transação: 

 

ProductTypeCode é o atributo identificador na Transação ProductType (mais especificamente, é a chave 

primária dessa Transação). Assim, quando uma chave primária é incluída em outra Transação, GeneXus 

entende que o atributo tem ali o papel de uma chave estrangeira. 

 

Incluir um atributo que seja chave primária de uma Transação em outra Transação permite que as 

duas Transações sejam relacionadas. 

 

GeneXus estabelece relações através de nomes de atributos, portanto, quando encontra atributos com o 

mesmo nome em diferentes Transações, assume que se referem ao mesmo conceito. 

 

O atributo ProductTypeName também está presente em ambas as Transações. No entanto, não está 

marcado como identificador para nenhuma das Transações definidas. Portanto, GeneXus entenderá que 

é um atributo secundário. GeneXus incluirá ProductTypeName na tabela física ProductType que criará no 

banco de dados e não na tabela física Product. 

 

O conceito de Transação e o conceito de tabela física não são os mesmos. Lembre-se que a Transação 

é o objeto GeneXus que você cria na Base de Conhecimento para representar um objeto de realidade. 

Considerando sua estrutura e as demais estruturas de Transação definidas na Base de Conhecimento 

(e também levando em conta algumas propriedades), GeneXus determinará as tabelas físicas que 

devem ser criadas no banco de dados, bem como os atributos que devem ser armazenados em cada 

tabela .  

 

Durante a execução da interface Web da Transação do Produto, o usuário deve inserir um valor para o 

atributo ProductTypeCode (que é um atributo de chave estrangeira) que foi previamente cadastrado 

através da Transação ProductType. Caso contrário, será mostrado um erro. Ao inserir um 

ProductTypeCode válido, seu valor ProductTypeName será obtido e exibido na tela. 
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GERAÇÃO E EXECUÇÃO DA APLICAÇÃO PELA PRIMEIRA VEZ.  

 

Se você deseja gerar e executar o aplicativo pela primeira vez, basta pressionar F5 e a seguinte caixa de 

diálogo será exibida: 

 

 

Use as credenciais da sua conta GeneXus para preencher os seguintes campos: 

● Nome de usuário ou e-mail correspondente à sua conta GeneXus. 

● Senha correspondente à sua conta GeneXus. 

Em seguida, pressione o botão OK. 
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GeneXus avaliará o impacto causado pelas novas definições na Base de Conhecimento e exibirá um 

relatório chamado Análise de Impacto (Impact Analysis): 

 

Este relatório mostra quais mudanças estruturais precisam ser feitas no banco de dados. Observe que, 

neste caso, o título principal informa que as tabelas do banco de dados serão criadas (“The Database 

tables will be created”). 
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Ao clicar em cada tabela (ProductType e Product na janela da esquerda), você verá na janela da direita os 

atributos que serão incluídos nelas: 
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Observe que, conforme explicado, o atributo ProductTypeName não está incluído na tabela física do 

Produto que será criada, apesar de você tê-lo incluído na estrutura da Transação do Produto (para exibir 

seu valor na interface Web do Transação). Transação). 

 

Se você concorda com a Análise de Impacto, pode clicar no botão Criar e GeneXus começará a criar os 

programas necessários para criar o banco de dados (que ainda não existe), assim como as tabelas com 

suas estruturas nesse banco de dados. Em seguida, GeneXus executa esses programas e depois de criar o 

banco de dados e as tabelas, gerará todas as linhas de código necessárias, na linguagem de 

programação selecionada, para obter o aplicativo que permitirá aos usuários inserir, atualizar e excluir 

tipos de produtos e produtos. . 

 

Você será informado se o resultado foi bem-sucedido ou se houve algum erro ou aviso. Então você pode 

executar e testar a execução. Isso abrirá a janela Launchpad, que oferece uma maneira rápida de 

executar os objetos definidos. 

 

Clique no link ProductType: 

 

A página que se abre permite ao usuário adicionar, atualizar e excluir tipos de produtos. Digite o primeiro 

tipo de produto. 
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Como o atributo ProductTypeCode tem a propriedade Autonumber configurada como True, você não 

precisará inserir um valor para o identificador, pois ele será numerado automaticamente. Portanto, insira 

o nome do tipo de produto: 

 

Após inserir o nome do tipo de produto e clicar no botão Confirmar, aparecerá uma mensagem 

informando que os dados foram adicionados com sucesso. Em seguida, a página estará vazia e pronta 

para inserir outro tipo de produto: Após inserir o nome do tipo de produto e clicar no botão Confirmar, 

aparecerá uma mensagem informando que os dados foram adicionados com sucesso. A página estará 

vazia e pronta para inserir outro tipo de produto: 
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Insira o segundo tipo de produto: 

 

Clique no botão Confirmar. Você pode navegar e verificar os dados para confirmar que está numerado: 
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Agora, execute a Transação Product. Para isso, volte ao Launchpad e execute a Transação do Produto 

selecionando seu link: 

 

Adicione o primeiro produto. Deve indicar o tipo de produto. Se você se lembrar do código do tipo de 

produto, poderá inseri-lo. Outra opção é selecioná-lo em uma lista clicando na seta marcada. 
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Agora, tente remover o tipo de produto "Medicinas". Para isso, selecione esse tipo de produto e pressione 

o botão Deletar: 

 

Uma mensagem informará que a exclusão não pode ser realizada porque há dados relacionados no 

Produto (o medicamento para dor muscular STAR é um produto que pertence a este tipo de produto). 

 

 

A APLICAÇÃO CRESCE 

 

Provavelmente você já reparou em tudo que GeneXus gerou automaticamente a partir dos dois objetos 

que você definiu. 

 

Agora, suponha que a farmácia lhe diga que, para cada produto, deseja registrar uma imagem. 

 

Para isso, volte ao GeneXus e, na Transação do Product, basta inserir um atributo chamado 

ProductPhoto: 
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O tipo de imagem permite armazenar imagens. 

 

A interface da Web (Web Layout) é atualizada automaticamente, incluindo o atributo ProductPhoto. 

 

Pressione F5 e GeneXus avaliará o impacto causado pelas novas definições na Base de Conhecimento. 

Em seguida, será mostrado o Relatório de Análise de Impacto (Impact Analysis Report): 

 
 

Lembre-se: O Relatório de Análise de Impacto indica as mudanças estruturais que precisam ser feitas 

no banco de dados. 

 

 

Ao ler o relatório, você verá que o título principal, neste caso, afirma que é necessária uma 

reorganização do banco de dados. O termo “Reorganizar” refere-se à tarefa de fazer alterações no banco 

de dados. Nesse caso específico, o relatório indica que precisa ser atualizada a tabela Product. 

 

Ao clicar no botão Reorganizar, GeneXus criará e executará os programas que realizarão as alterações no 

banco de dados. Em seguida, ele gerará os programas necessários que correspondem ao aplicativo. 
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Observe que você terá imediatamente o aplicativo em execução novamente no navegador da Web, com a 

nova definição incluída: 

 

 

Se você se lembrar do código do produto, poderá inseri-lo. Outra opção é selecioná-lo em uma lista 

clicando no botão SELECIONAR. A partir daí, você pode recuperar o produto “STAR muscular pain 

medicine” e fazer upload de sua foto: 
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AGREGAR REGRAS DE NEGÓCIOS 

 

Além de todos os controles automáticos que GeneXus inclui nas aplicações que gera, às vezes quem 

solicita a aplicação pede alguns controles específicos. Em Transações, as regras que devem ser 

atendidas, ou os controles que devem ser executados, são definidos na seção Rules. 
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Se, por exemplo, um requisito é que produtos sem nome não possam ser salvos, GeneXus oferece uma 

regra chamada Error que permitirá evitar isso: 

 

Pressione F5 e GeneXus salvará e avaliará as novas definições incluídas na Base de Conhecimento. Nesse 

caso, deduzirá que o banco de dados não precisa ser modificado, portanto, não exibirá um Relatório de 

Análise de Impacto. GeneXus gerará o código necessário e então executará a aplicação atualizada com as 

novas definições. 

 

Execute a Transação Product. Observe que se você deixar o nome do produto em branco, a regra que 

você definiu será executada: 
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Existe outra regra cuja sintaxe é muito semelhante à regra de erro. Chama-se Msg e a única diferença 

entre eles é que se a condição for atendida, neste caso a mensagem é exibida como um aviso ou aviso, e 

o usuário pode continuar trabalhando. 

 

Se, por exemplo, você deseja informar que o preço do produto está em branco sem forçar o usuário a 

digitá-lo, você pode adicionar a seguinte regra na Transação Product: 
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Este conjunto de regras poderia ser escrito em qualquer outra ordem e o resultado em tempo de 

execução seria exatamente o mesmo, pois GeneXus analisa e determina quando cada uma das regras 

definidas deve disparar (quando o usuário sai de cada campo, se a condição for verdadeira, etc.). 

 

É claro que há mais regras disponíveis no GeneXus para definir diferentes tipos de validações e ações. 

 

Cada Transação deve ter suas próprias regras de comportamento definidas. 

 

DEFINIR CÁLCULOS: FÓRMULAS 

 

Muitas vezes, os aplicativos são solicitados a realizar cálculos envolvendo os valores de determinados 

atributos, constantes e/ou funções específicas. Para estes casos, GeneXus se oferece para definir 

Fórmulas. 

 

Existem diferentes maneiras possíveis de definir fórmulas. 

 

O que é uma fórmula global? Uma fórmula global é um cálculo que o desenvolvedor define associado a 

um atributo. Observe que as estruturas de transação contêm uma coluna chamada Fórmula: 

 

Quando um cálculo é definido nesta coluna para um atributo, significa que o atributo é virtual. Em outras 

palavras, ele não será criado fisicamente como um campo em uma tabela, pois o valor do atributo será 

recuperado toda vez que for necessário fazer o cálculo. 

 

Suponha que a farmácia precise saber a todo momento quantos produtos registrados existem de cada 

tipo de produto. Para resolver isso, crie um novo atributo na transação ProductType para defini-la como 

uma fórmula global: 
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Agora, defina o cálculo associado ao atributo ProductTypeProductQuantity. 

 

GeneXus oferece uma fórmula chamada Contagem para resolver a necessidade solicitada pela farmácia 

(existem muitas outras, como Soma, Média, etc.). 

 

O atributo que está dentro dos parênteses da fórmula dá ao GeneXus a informação de qual tabela 

navegar para fazer o cálculo (na definição anterior, ProductName está dentro dos parênteses; portanto, 

GeneXus sabe que deve contar na tabela Product). Então, se GeneXus detecta uma relação entre a tabela 

a ser navegada (Product) e o contexto onde está definido o atributo da fórmula (ProductType), só 

considerará os registros relacionados ao realizar o cálculo. Neste exemplo, o atributo ProductTypeId está 

presente em ambos os contextos: onde a fórmula está definida e na tabela na qual deve ser realizada a 

navegação para obter o cálculo. Portanto, para cada tipo de produto, serão contabilizados apenas os 

produtos daquele tipo de produto (ao invés de contar todos os produtos cadastrados na tabela 

navegada). Se nenhuma relação for encontrada, GeneXus fará o cálculo considerando todos os registros 

da tabela navegada. 

 

Pressione F5. Não há alterações físicas a serem feitas no banco de dados. GeneXus gerará apenas alguns 

programas e o Launchpad será executado novamente: 
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Executa a Transação ProductType. Você verá como a quantidade de produtos de cada tipo é sempre 

calculada para cada tipo de produto, no momento: 

 

 

Você pode adicionar mais produtos e verificar se o número de produtos de cada tipo é sempre calculado 

no local. 
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USO DE PADRÕES (PARA WEB E PARA DISPOSITIVOS MÓVEIS) 

 

Os padrões permitem que você aprimore ainda mais seus aplicativos, automaticamente. 

 

Aplicar um padrão é muito fácil, e GeneXus cria imediatamente objetos, códigos e configurações para 

fornecer comportamentos úteis sem a necessidade de programá-los. 

 

Veja a seção Patterns de uma Transação. Por exemplo, na transação ProductType, selecione a seção 

Patterns: 

 

 

 

Observe que há duas guias disponíveis, cada uma oferecendo um padrão diferente para aplicar à mesma 

Transação. 

 

Primeiro, selecione a guia Work With for Web. 
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Para aplicar o padrão Work With for Web deve apenas clicar na caixa de seleção Apply this pattern on 

save e guardar ( ): 

 

 

Em seguida, se você procurar a Transação ProductType no KB Explorer, poderá ver que existem vários 

novos objetos abaixo da Transação: 

 

Foram criados por GeneXus por terem aplicado o padrão Work With for Web. 
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Agora pressione F5 para ver os resultados em tempo de execução: 

 

Observe o último link mostrado (WWProductType). Ele se oferece para “trabalhar com tipos de produtos” 

(e a partir daí há invocações para a Transação ProductType). Clique nesse link. 

 

 

Você pode ver uma página aberta que lista todos os tipos de produtos. Esta página permite que os 

usuários trabalhem com tipos de produtos com uma variedade maior de funcionalidades. 
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Por exemplo, clique em UPDATE para a primeira linha: 
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Você pode ver que abre a transação ProductType oferecendo para editar os dados do tipo de produto 

que está nessa linha. Renomeie o tipo e confirme: 

 

Após editar e confirmar, o app volta para a página Work With Product Types (Trabalhar com tipos de 

produtos) e você já pode ver a alteração: 

 

O link DELETE permite remover o tipo de produto da linha. 
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Além disso, o botão INSERIR localizado fora da grade permite adicionar novos tipos de produtos. 

Clicar no botão INSERIR abre a Transação ProductType, pronta para adicionar um novo tipo de produto. 

Pressione-o para inserir um novo tipo de produto (lembre-se que neste caso só é necessário inserir o 

nome do tipo de produto porque você definiu a propriedade Autonumber do atributo chave como True): 
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Após a inserção, o aplicativo retorna novamente à página Work With Product Types: 

 

Agora observe que cada nome de tipo de produto tem um link. Clique no link: Medicines. 
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Como você pode ver, a primeira guia mostra todos os detalhes do tipo de produto selecionado (General 

Tab): 

 

Outra guia (Product Tab) mostra a lista de produtos que pertencem a esse tipo de produto: 

 

A guia Produto foi gerada automaticamente porque cada tipo de produto possui vários produtos 

relacionados. Se cada tipo de produto também tivesse vários dados relacionados de outro tipo, mais 

guias seriam geradas para exibir cada lista de dados relacionados ao tipo de produto. 

 

Agora, volte para a página Work With Product Types, clicando no link que aparece no canto superior 

esquerdo da página. 
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Observe que é possível pesquisar por nome. Isso significa que se, por exemplo, o usuário digitar "C", 

apenas os tipos de produto que começam com esta letra serão exibidos: 

 

Volte ao GeneXus. Até agora, você só selecionou Apply this pattern on save na guia Work With for Web da 

Transação ProductType e, após salvar, você viu todas as funções que foram geradas automaticamente. 
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O que você pode não ter notado é esta árvore configurável: 

 

 

Possui nós, subnós e elementos configuráveis, sendo possível personalizar os comportamentos a serem 

gerados (ou seja, alterar ou adicionar critérios de pesquisa, etc.). 
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Agora aplique o padrão Work With for Web também à Transação Product. Conforme explicado 

anteriormente, basta abrir a Transação Product e em sua seção Patterns, deve-se selecionar a aba Work 

With for Web. Lá você deve marcar a opção Apply this pattern on save e salvar: 

 

Pressione F5. GeneXus gera os programas necessários e executa a aplicação com as mudanças. Execute a 

página Work With Product: 

 

Você pode ver as mesmas funções de consulta que já viu na página Work With Product Types:  
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Insira um novo produto: 

 

Depois da confirmação, a aplicação retorna a página Work With Product: 
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Como é irrelevante mostrar o código do tipo de produto na grade, remova-o da árvore configurável que é 

considerada para gerar este Work With for Web: 

 

 

Pressione F5, GeneXus salvará o que foi feito, gerará apenas os programas necessários e executará a 

aplicação com as alterações. 

 

Adicione alguns produtos da mesma forma mostrada acima (pressionando o botão INSERT que invoca a 

Transação Product). 
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Abaixo está a página Work With Products que lista todos os produtos que foram adicionados: 

 

Agora preste atenção na guia Work With oferecida para cada Transação. Aplique-o à Transação 

ProductType: 
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Ao contrário do padrão Work With for Web, neste caso, o layout (Layout) já é exibido com uma grade em 

vez de uma lista de atributos abaixo do nó a ser incluído em uma grade. 

 

Dê uma olhada no nó Detail, que permite ver os detalhes de uma determinada linha de grade. 

 

O nó Detail é composto de duas seções: General e Product. 

 

Assim como a funcionalidade implementada pelo padrão Work With for Web, a seção General exibe os 

dados associados ao tipo de produto selecionado e a seção Product exibe todos os produtos que 

pertencem ao tipo de produto em uma grade. 
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Após aplicar este padrão e salvar, se você localizar a Transação ProductType no KB Explorer, agora 

poderá ver abaixo dele um novo objeto chamado WorkWithProductType: 
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Observe os dois objetos gerados na transação ProductType. Observe que WorkWithProductType não 

possui outros objetos abaixo dele (porque inclui diferentes seções para definir a implementação 

completa dentro dele). 

Em vez disso, WorkWithWebProductType é uma instância configurável; e a partir dessa instância GeneXus 

gera outros objetos para fornecer os comportamentos úteis que foram vistos. 

Em breve você verá o componente WorkWithProductType em ação. 

A proposta agora é criar um objeto Menu, para ser o primeiro objeto da aplicação a ser executado. Ele 

exibirá um ícone, para que quando o usuário clicar nele, o objeto WorkWithProductType seja executado. 

Como explicado acima, para criar um objeto basta selecionar File > New > Object: 

 

Por padrão, todo Menu criado tem sua propriedade Main program = True, de modo que este objeto é um 

objeto executável autônomo (ou seja, é compilável e executável por conta própria).  
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Agora, arraste o objeto WorkWithProductType da janela KB Explorer para o nó Itens do Menu: 

 

A ação mostrada abaixo do nó Itens é adicionada automaticamente e um evento associado à ação é criado: 
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Para entender a linha de código dentro do evento, dê outra olhada no nó de árvore configurável contido 

no objeto WorkWithProductType: 

 

O objeto tem um nó principal (Level( ProductType)). Abaixo dele você pode ver os nós List e Detail 

respectivamente, então para chamar o nó List a sintaxe completa é: 

 

Agora edite a propriedade Description do nó Action para ler “List of Product Types”: 

 

Tudo foi definido e pronto para rodar o aplicativo Mobile. 
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Como o objeto PharmacyMenu tem sua propriedade Main Program definida como True, você pode 

executá-lo independentemente do KB Explorer clicando com o botão direito do mouse no objeto e 

selecionando Run: 
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A execução pode ser feita em um dispositivo móvel conectado ao seu computador ou por meio de um 

emulador instalado em seu computador: 
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Ao tocar na imagem, é apresentada a lista de tipos de produtos oferecidos pela farmácia: 

 

Observe que o botão Inserir no canto superior direito pode ser facilmente removido, pois este aplicativo é 

para usuários finais e não queremos que eles possam inserir novos produtos; eles só precisam ser 

capazes de ver os diferentes tipos de produtos. 

 

  



 

 

                                                                   

www.genexus.com      |       56 

Tocar em cada tipo de produto (por exemplo, "Cosméticos para Adolescentes") abre o Detail com suas 

duas seções GENERAL e PRODUCT: 

 

 

Obviamente, esta é apenas uma demonstração muito simples, pois aplicativos muito mais sofisticados 

podem ser alcançados.  
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GERAÇÃO DO QUE FOI DEFINIDO ATÉ AGORA EM OUTRA LINGUAGEM E/OU PARA OUTRO BANCO DE DADOS 

 

Como mencionado acima, uma das grandes vantagens de GeneXus é que permite gerar o mesmo 

aplicativo para diferentes plataformas, gerar código em diferentes linguagens de programação e/ou 

armazenar os dados do aplicativo em diferentes bancos de dados. Todas essas informações são 

definidas em um Environment. 

Um Environment permite configurar e armazenar todas as informações relacionadas a uma 

determinada implementação de sua aplicação (os geradores que você deseja usar para gerar o Back-

end de sua aplicação, os geradores que deseja usar para gerar o Front-end, os dados de informações de 

banco de dados, etc). 

Vá para a janela Preferências, clicando na guia ao lado da guia KB Explorer: 

 

Há um único Environment definido (.NET Environment). Ele foi criado automaticamente no momento da 

criação da Base de Conhecimento quando você escolheu .NET como idioma de geração. Ele foi então  

preenchido com mais informações quando você pressionou F5 pela primeira vez e forneceu informações 

sobre o banco de dados a ser criado e o servidor de banco de dados. Os subnós de Environment 

permitem configurar mais propriedades. 
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É possível criar mais de um Environment para a mesma Base de Conhecimento. Por exemplo, é comum 

criar um Environment para desenvolvimento onde você se conecta a um banco de dados com dados de 

teste e outro Environment para produção, onde você define o servidor e o banco de dados que você 

utilizará para o sistema finalizado. 

 

Você também pode querer criar, na mesma Base de Conhecimento, um novo Environment para gerar 

tudo para uma plataforma diferente (por exemplo, gerar o código em Java e usar outro DBMS como 

Oracle, MySQL, PostgreSQL, DB2 ou outros. E para a geração Front-end você pode usar Apple ou Angular). 

 

Conforme mostrado na imagem a seguir, para criar um novo Ambiente, você deve clicar com o botão 

direito do mouse no nó Environment, selecionar New Environment e configurar as propriedades 

necessárias. 

 

 

Para optar por trabalhar com um Environment ou outro, você deve clicar com o botão direito do mouse 

no Environment que deseja ativar e selecionar Set as current (Definir como atual). 

 

Você pode identificar facilmente o Environment ativo pelo símbolo PLAY. 

 

Saiba mais sobre como criar um novo ambiente. 

  

https://wiki.genexus.com/commwiki/servlet/wiki?24702,Create+new+environment+dialog,
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O QUE MAIS OFERECE GENEXUS? 

 

- Acesso a Bancos de Dados externos 

● Pode ser necessário acessar bancos de dados externos de aplicativos GeneXus. Por 

exemplo, carregar dados de um banco de dados externo nas tabelas de banco de dados 

associadas à Base de Conhecimento para realizar um carregamento inicial. Em seguida, 

você pode não precisar ficar conectado a esse banco de dados externo, ou pode precisar 

se conectar e estar sempre conectado a uma determinada tabela ou tabelas em um ou 

mais bancos de dados externos (não apenas para lê-los, mas também para acessar e 

alterar o dados neles). GeneXus oferece um “processo de engenharia reversa” para 

conectar-se a tabelas de banco de dados externas para atender às necessidades 

descritas acima. 

- Suporte de Desenvolvimento Colaborativo 

● GeneXus Server oferece a opção de carregar uma Base de Conhecimento para um 

servidor. Feito isso, novos desenvolvedores localizados em qualquer lugar 

geograficamente podem se conectar à Base de Conhecimento do servidor e criar uma 

cópia local. Eles podem trabalhar (sempre localmente) e enviar suas alterações para o 

servidor. Claro, existe um mecanismo para a resolução de conflitos. Esta solução oferece 

muitas vantagens, incluindo controle de versão dos modelos na Base de Conhecimento. 

  

-  Consumir e definir serviços web 

● É possível consumir web services desenvolvidos por terceiros a partir de uma aplicação 

GeneXus, assim como você também pode desenvolver seus próprios web services com 

GeneXus. 

  

- Definir atualizações massivas de banco de dados e defina livremente outros tipos de 

processos. 

 

- Definir painéis interativos e personalizados para aplicativos web e aplicativos para 

dispositivos móveis. 

 

- Projetar e ajustar interfaces de usuário (UIs) 

● GeneXus oferece o poder de personalizar a interface do usuário e, como a experiência do 

usuário é extremamente importante, oferece geradores específicos para aplicativos nativos, 

aplicativos com web design responsivo, web móvel, etc. Ele também oferece um recurso de edição 

ao vivo multiplataforma que simplifica o processo de projetar seu aplicativo e criar um protótipo ao 

vivo (Live Prototyping). 
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- Implementar  seu aplicativo em produção em servidores locais ou provedores de serviços em 

nuvem 

 

● Com o clique de um botão, você pode implantar seu aplicativo em produção. 

 

- Documentar dentro da Base de Conhecimento 

 

● GeneXus oferece um editor de Documentação estilo Wiki, para que você possa descrever 

facilmente a finalidade da Base de Conhecimento (em um objeto do tipo Documentação, 

chamado Main, que é criado automaticamente em cada Base de Conhecimento). 

 

Além disso, todos os objetos GeneXus possuem uma guia Documentação, onde também é 

possível descrever a finalidade do objeto. 

 

Ao escrever a documentação, você pode incluir texto, imagens, links para atributos, objetos, 

etc. Os arquivos também podem ser armazenados na Base de Conhecimento como parte 

de sua documentação. 

- Inteligência Artificial  

● GeneXus oferece capacidades para integrar fácilmente a Inteligência Artificial (IA). 

 

- Gerador de chatbot 

● GeneXus inclui um gerador de Chatbot para criar e implementar automaticamente um 

chatbot em qualquer um dos provedores de Chatbot suportados. 

  

- Extensibilidade 

● GeneXus permite a criação de extensões específicas, que permitem aos desenvolvedores 

aproveitar diferentes linguagens de plataforma para criar soluções específicas e ampliar 

as capacidades centrais de GeneXus. 

 

- Integração de sistemas externos e fontes de dados em uma aplicação GeneXus 

 

● GeneXus ERP Connector for SAP permite desenvolver aplicações integradas com SAP 

ERP, permitindo complementar as funcionalidades que oferece. 

 

 

 

https://wiki.genexus.com/commwiki/servlet/wiki?40167,Toc%3AGeneXus+Artificial+Intelligence,
https://wiki.genexus.com/commwiki/servlet/wiki?37102,Chatbot+generator,
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- Gestão da segurança 

● GeneXus oferece um módulo de segurança (totalmente integrado ao GeneXus), chamado 

GeneXus Access Manager (GAM). Apenas ao habilitá-lo, oferece resolve as funcionalidades 

de autenticação e autorização, tanto para aplicações web quanto para dispositivos 

móveis e dispositivos inteligentes. 

  

- Modelar e automatizar processos de negócios 

● GeneXus conta com um conjunto de ferramentas que permitem a modelagem e 

automação dos processos de negócio, bem como um ambiente de execução para 

gerenciá-los. A ferramenta de modelagem GeneXus Business Process Modeler é baseada 

no padrão BPMN 2.0 e é destinada a usuários cujo objetivo é modelar processos de 

negócios. Esses diagramas podem ser integrados ou criados no ambiente de 

desenvolvimento GeneXus para implementar a etapa de automação, onde, através de 

GeneXus, os diferentes objetos são associados em cada tarefa modelada nos processos. 

GXflow oferece ferramentas de execução, administração e monitoramento para usuários 

finais. Desta forma, GeneXus oferece o que conhecemos como GeneXus BPM Suite, que é 

o conjunto de ferramentas que permitem o desenvolvimento de sistemas baseados em 

Business Process Management, ou seja, sistemas orientados a processos de negócio. 

 

- Relatórios 

● Definição de relatórios estáticos (listas típicas que podem ser impressas, salvas ou 

exibidas na tela). 

 

● Definição de consultas visuais e dinâmicas. 

▪ Você pode criar consultas de banco de dados, agrupar dados de acordo com um 

ou vários critérios, realizar cálculos e, finalmente, exibir o resultado em diferentes 

tipos de gráficos, tabelas dinâmicas e tabelas. Para realizar este tipo de consulta, 

GeneXus oferece o objeto Query e o controle Query Viewer. 

▪ Além disso, o produto GXquery permite que os usuários finais realizem consultas 

de forma dinâmica, com base no mesmo modelo de dados da Base de 

Conhecimento. Essa ferramenta foca em possibilitar o acesso e análise de dados 

na própria base de dados operacional do sistema, e fornece ao usuário uma 

interface intuitiva a partir da qual ele pode criar suas próprias consultas e depois 

visualizá-las através da interface web e do app mobile, ou integrado no Microsoft 

Office Excel. 
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-  Desenvolvimento compartilhado e Marketplace 

● GeneXus Marketplace permite que os desenvolvedores compartilhem seus controles de 

usuário, extensões, padrões, ferramentas externas e objetos externos criados para e com 

GeneXus. 

                                                                                                                                       

- Teste de aplicações com GXtest  

● Quando novos recursos ou variações são implementados, é necessário verificar se o que 

já funcionava (antes das alterações) continua funcionando corretamente. Esse tipo de 

tarefa pode se tornar muito tedioso se o aplicativo crescer muito, pois o número de 

coisas a testar aumentará a cada vez, etc. GeneXus ajuda a automatizar esses testes por 

meio de seu software GXtest, permitindo que as sequências de operação sejam salvas 

para testes. Os testes são reproduzidos automaticamente, verificando se o sistema ainda 

está funcionando corretamente. 

 

 

PRÓXIMOS PASSOS 

 

Você chegou até aqui se familiarizando com GeneXus, então a pergunta natural é “Qual é o próximo 

passo?” 

- Primeiro do primeiro: 

●  Acesse o seguinte curso on-line para continuar aprendendo: 

▪ https://training.genexus.com/en/learning/courses/genexus/v18/core 

▪ Se você ainda não experimentou GeneXus, pode fazê-lo gratuitamente neste link: 

http://genexus.com/trial 

- Aprenda mais: GeneXus é uma plataforma de desenvolvimento muito completa, e há muito o 

que ler e aprender. Você poderia começar a aprofundar em: 

● Site de Capacitação GeneXus: http://training.genexus.com/ 

● GeneXus Wiki:  http://wiki.genexus.com/ 

  

https://marketplace.genexus.com/home.aspx?,en
https://training.genexus.com/en/learning/courses/genexus/v17/core
http://genexus.com/trial
http://training.genexus.com/
http://training.genexus.com/
http://wiki.genexus.com/
http://wiki.genexus.com/
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- Obtenha GeneXus! Nós nos esforçamos para fornecer a melhor ferramenta para simplificar o 

desenvolvimento de software, e é por isso que tratamos cada novo cliente como o primeiro. 

Contacte-nos em info@genexus.com ou visite http://genexus.com/plans  para ver qual é o mais 

adequado para si. 

  

- Faça parte da nossa comunidade: Quando estiver pronto, você pode se juntar à nossa 

comunidade em constante crescimento por meio de uma ampla variedade de opções: 

● Publique seu trabalho em nosso Marketplace:  http://marketplace.genexus.com/ 

● Trabalhe com GeneXus: http://genexus.com/company/work-with-us?en 

● Oportunidades oferecidas por nossos parceiros: 

http://genexus.com/jobs/Opportunities?en 

● Faça parte da GeneXus Alliance:  http://genexus.com/partners 

● Assista ao próximo Encontro GeneXus: http://genexus.com/meetings 

 

Nós realmente esperamos ter notícias de você em breve! 
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